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SLIKA 1.1
U okviru za dijalog Preferences, navešćete radne diskove.

Za DV učitavanje (učitavanje digitalnog videa), diskove morate podesiti na odgova-
rajuću brzinu obrtanja (7200 o/min), a ako učitavate na spoljne FireWire uređaje, pobrinite 
se da oni ne budu lančano povezani (slika 1.2).
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SLIKA 1.2
FireWire uređaj E: povezan je s računarom preko FireWire kabla, a uređaj 
F:je lančano povezan sa uređajem E: preko FireWire kabla. Uređaj F: se ne 
može koristiti za DV učitavanje i reprodukovanje.

Da biste zadali parametre za kontrolisanje DV uređaja, odaberite Edit>Preferences> 
Device Control. U oknu Device Control okvira za dijalog Preferences (slika 1.3), sa 
padajuće liste Devices izaberite metodu kontrolisanja uređaja, a zatim ručno podesite kon-
trole tako što ćete pritisnuti dugme Options i uneti odgovarajuće informacije za uređaj 
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koji koristite (slika 1.4.). Svaka kamera ili video-rikorder ima jedinstven protokol i metodu 
komuniciranja preko kontrola uređaja, i važno je da njihove opcije podesite pre nego što 
počnete učitavanje. 

SLIKA 1.3
Parametre za kontrolisanje uređaja možete zadati u okviru za dijalog  
Preferences.

SLIKA 1.4
U okviru za dijalog Device Con-
trols Options, navešćete video-stan-
dard, marku i vrstu uređaja. Pritis-
nite dugme Check Status da biste 
proverili da li uređaj komunicira s 
programom Premiere Pro. Poruka 
Offline znači da komunikacije nema, 
a Online znači da ona postoji.

Još kada sam počinjao da radim u programu Premiere, navi-
kao sam da uvek uključim kameru i povežem FireWire kabl 
pre nego što pokrenem Premiere Pro. I sada možemo ispravno 
pretpostaviti da će komunikacija sa uređajem početi brže kada 
otvorite program. Ipak, to nije jedina mogućnost. Pošto Win-
dows XP podržava uključivanje spoljnih uređaja tokom rada 
(engl. hot plugging), tj. učitava upravljačke programe i akti-
vira uređaj bez potrebe da ponovo podižete sistem, kameru 
možete uključiti bilo kad dok radite u programu Premiere. 
Ne preporučujem da kameru uključujete i isključujete tokom 
rada, ali ukoliko vam se isprazni baterija ili hoćete da isključite 
kameru, neće se desiti ništa loše ni programu ni vama. Kada 
usred rada u programu uključite kameru, možda ćete morati  
da sačekate 10–20 sekundi da se učitaju upravljački programi  
i počne komunikacija i prenos. 

Lančano povezivanje (engl. daisy 
chaining) jeste povezivanje  više 
spoljnih uređaja. FireWire uređaji 
obično imaju dva ulazno/izlazna 
priključka. Ukoliko računar ima samo 
jedan FireWire ulaz, lančano se pove-
zuju oba uređaja da bi ih računar pre-
poznao. Prvi uređaj, (E:), povezaćete 
s računarom preko FireWire ulaza, 
a drugi, (F:), povezaćete preko 
dodatnog FireWire ulaza na prvom 
uređaju, pa će ga računar prepoznati 
kao dodatan uređaj na sistemu. 
Mada je u redu da uređaje podes-
ite na ovaj način, DV specifikacije ne 
podržavaju ovu konfiguraciju pri-
likom učitavanja digitalnog videa sa 
DV uređaja.
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Novine u učitavanju
Pošto podesite parametre uređaja i uključite kameru, možete 
početi šetnju po prozoru Capture. Da biste ga otvorili, oda-
berite File>Capture ili pritisnite F5 (slika 1.5.).

SLIKA 1.5
Novi prozor Capture, koji je uveden od verzije Premiere Pro, sadrži kom-
pletne kontrole premotavanja, reprodukovanja i snimanja, napredne 
funkcije evidentiranja i detekciju scene.

Na levoj strani nalazi se prostor za pregledanje signala koji se prenosi u prozor Capture. 
Traka pri vrhu uvek sadrži povratne informacije o tome šta prozor Capture radi – premo-
tava, reprodukuje, serijski učitava odlomke itd. Ispod prostora za pregledanje nalazi se 
područje za informacije o vremenskom kodu. U njemu je prikazan (sleva) vremenski kôd 
tekuće slike, označena ulazna tačka (In), označena izlazna tačka (Out) i raspon između 
ulazne i izlazne tačke. Ispod vremenskog koda nalaze se kontrole prenosa (engl. transport 
controls) raspoređene u tri odeljka (slika 1.6).

Ukoliko je DV kamera uključena 
i povezana, a sa nje ne možete 
da prenosite video ili da s njom 
komunicirate, proverite sta-
tus uređaja u okviru za dijalog 
Device Control Options. Odaberite 
Edit>Preferences>Device Con-
trol, pa pritisnite dugme Options. 
Ako je navedeno da je uređaj pove-
zan (Online), a ne možete da na 
njega prenosite video, isključite 
uređaj i ponovo ga uključite. Kada 
ga isključite, trebalo bi da čujete 
Windowsov zvuk za isključivanje 
uređaja, a kada uređaj uključite, 
trebalo bi da čujete zvuk za 
uključivanje. Ja obično proverim sve 
utičnice i ponovo uključim FireWire 
kabl. Proverite i da niste negde 
pogrešili, na primer, da niste preba-
cili kameru u režim Camera umesto 
u režim VCR ili VTR.

Sledeća 
scena

Zadavanje ulazne tačke
Zadavanje izlazne tačke

Prethodna 
scena

Prelazak na ulaznu tačku
Prelazak na izlaznu tačku Klizač za zadavanje 

brzine reprodukovanja

Točkić za premotavanje 
kadar po kadar

Sporo reprodukovanje unazad
Sporo reprodukovanje

Premotavanje 
unazad

Postepeno premotavanje unazad
Reprodukovanje

Postepeno premotavanje unapred
Brzo premotavanje unapred

Pauza Zaustavljanje

Snimanje

Uključivanje 
i isključivanje 
detekcije scene

SLIKA 1.6

Kontrole prenosa su organizovane u tri odeljka: levi, srednji i desni.
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Kontrole prenosa
Na početku levog odeljka s kontrolama transporta nalazi se dugme za prelazak na sledeću 
scenu (Next Scene) i dugme za prelazak na prethodnu scenu (Previous Scene). Dugmad 
pritisnite onoliko puta koliko scena želite da napredujete unapred ili unazad: dva pritiska 
pomeriće vas za dve scene. Dok premotavate unazad za određeni broj scena, u području 
za pregledanje videćete poruku. Na primer, ukoliko dvaput pritisnete dugme za prelazak 
na prethodnu scenu, poruka će glasiti „Searching 2 Scenes Back“ – program traži 2 scene 
unazad. Sledeća dugmad su prilično jednostavna i uobičajena su u većini drugih prozora 
za praćenje (Monitor). Gornji red sadrži dugmad za zadavanje ulazne tačke (Set In Point) i 
izlazne tačke (Set Out Point), a u donjem redu se nalazi dugme za prelazak na ulaznu tačku 
(Go To In Point) i dugme za prelazak na izlaznu tačku (Go To Out Point). Ako ste zadali 
ulaznu ili izlaznu tačku, dugmad Go To premotaće traku do navedene tačke.

U gornjem redu srednjeg odeljka s kontrolama, pronaći ćete sličnu dugmad za upra-
vljanje trakom: dugme za premotavanje (Rewind), pomeranje za po jedan kadar unazad 
(Step Back), reprodukovanje (Play), pomeranje za po jedan kadar unapred (Step Forward) 
i brzo premotavanje unapred (Fast Forward). Ispod te dugmadi nalazi se klizač Shuttle koji 
dinamički menja brzinu reprodukovanja unapred ili unazad. Povucite ga udesno da biste 
ubrzali reprodukovanje unapred, a ulevo da biste ubrzali reprodukovanja unazad. Što je 
klizač dalje od centra, reprodukovanje je brže. Kada ga povučete skroz udesno dobićete 
rezultat kao da ste pritisnuli dugme za brzo premotavanje unapred, a ako ga pomerite vrlo 
malo udesno, brzina će se blago povećati. Na dnu srednjeg odeljka nalazi se točkić Jog 
koji premotava film kadar po kadar. Možete prevući pokazivačem preko točkića da bi on 
krenuo. Lepota ovog točkića je u tome što kada počnete da ga pomerate, vaš pokazivač 
miša neće izaći sa ekrana na levom ili desnom kraju. Ostaće na sredini točkića, pa možete 
premotavati do mile volje.

Desni odeljak s kontrolama, u gornjem redu sadrži dugmad za pauzu (Pause), zausta-
vljanje (Stop) i snimanje (Record). Dugme za sporo reprodukovanje unazad (Slow Reverse), 
sporo reprodukovanje (Slow Play) i prekidač za detektovanje scene (Scene Detect), nalaze se 
na dnu. Mada su vam sva ta dugmad na raspolaganju, smatram da je učitavanje mnogo efi-
kasnije kada koristite prečice s tastature.

J, K i L: više od običnih slova
Kada reprodukujete u prozoru Monitor ili prozoru Capture, najbitniji tasteri su J, K i L.  
Te prečice vam pomažu na sledeći način:

J Reprodukuje unazad normalnom brzinom; pritisnite taster još jednom za duplo 
brže reprodukovanje i još jednom za četiri puta brže
K Zaustavljanje 
Razmaknica Prestanak pauze i aktiviranje reprodukovanja, i obrnuto
L Reprodukuje unapred normalnom brzinom; pritisnite taster još jednom za duplo 
brže reprodukovanje i još jednom za četiri puta brže
R Premotavanje unazad
F Brzo premotavanje unapred
G Učitavanje

•

•
•
•

•
•
•
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Recimo da tokom normalnog učitavanja (ili evidentiranja) 
postepeno prolazite kroz traku. Pritisnite L da biste pokrenuli 
reprodukovanje. Ako hoćete da premotavate unapred najvećom 
brzinom, a da i dalje posmatrate video-snimak, pritisnite F – 
snimak će se reprodukovati veoma brzo, ali ćete i dalje moći 
da ga gledate. Kada ugledate nešto što vam se dopadne, pritis-
nite razmaknicu da biste zaustavili traku. Mogli biste i dvaput 
pritisnuti J da biste premotali malo unazad, L da biste ponovo 
pokrenuli reprodukovanje i na kraju G da biste pokrenuli 

učitavanje videa u program. Kada budete zadovoljni učitanim videom, ponovo pritisnite G 
(ili Esc ili Razmaknicu) da biste završili učitavanje. Dajte datoteci ime i nastavite dalje. Ako 
hoćete da premotavate unapred najvećom brzinom na kameri, pritisnite K da biste zaustavili 
reprodukovanje, a potom F da biste uključili brzo premotavanje unapred dok je kamera u 
režimu Stop i dobićete najbrže moguće premotavanje. Isto važi i za premotavanje unazad 
pomoću tastera R. Znači, lako ćete se kretati pomoću tastera J, K, L, F i R. Kada ugledate 
snimak koji tražite, pritisnite taster za pauzu (razmaknicu). Ako hoćete da ga pregledate 
kadar po kadar, koristite tastere sa stelicama ulevo i udesno da biste snimak pomerali una-
pred (desna strelica) ili unazad (leva strelica). Jedan pritisak na taster pomeraće vas za po 
jedan kadar, dva pritiska za dva kadra itd. Kombinacija tastera Shift+strelica pomeraće sni-

mak za po pet koraka. Kada završite rad s trakom, pritisnite K 
da biste je zaustavili i E da biste je izbacili iz uređaja. Ubacite 
sledeću traku i nastavite.

Evidentiranje sadržaja trake  
i kartica Logging
Ukoliko imate vremena, u programu uvek napravite eviden-
ciju sadržaja video-traka pre nego što počnete da ih obrađujete. 
Tako ćete sebe poštedeti mnogo zbrke.

Evidentiranje sadržaja trake sastoji se od pregledanja cele 
trake, beleženja ulaznih i izlaznih tačaka vremenskog koda za 
određene instance, i potom dodeljivanja jedinstvenog imena 
i raznih opisa tim instancama. Evidentiranje je korisno jer 
omogućava pregledanje opisa i tačnog vremenskog koda za 
svaki snimak na traci.

Trake ćete evidentirati pomoću kartice Logging (slika 1.7). 
Ona je podrazumevano otvorena na desnoj strani prozora  
Capture. Za upravljanje učitanim snimcima veoma je važno  
da se upoznate s poljima na ovoj kartici.

Prilikom evidentiranja video-snimaka, definišete njihove 
parametre. Pošto možete definisati više specifičnih vrednosti, 
Premiere Pro će vrlo lako napraviti datoteku evidentiranu za 
naknadno učitavanje (engl. offline file) u kojoj su primenjeni  
svi ti parametri.

Kada traku zaustavite na određenom 
mestu, čim pritisnete dugme Cap-
ture, kamera će početi da reprodu-
kuje i istovremeno snima.

SLIKA 1.7
Brojne informacije koje ručno 
unosite na karticu Logging pro-
zora Capture, dodaju se evidenti-
ranom snimku s trake ili odlomku 
učitanom u program.
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Na primer, kada evidenti-
rate zvučni i video odlomak 
nazvan Clip01 koji između 
ulazne i izlazne tačke traje 
deset sekundi, Premiere Pro 
će napraviti datoteku evi-
dentiranu za naknadno 
učitavanje u prozoru Project 
koja će imati iste parametre i 
ime kao taj odlomak. Štaviše, 
postojaće datoteka evidenti-
rana za naknadno učitavanje 
u trajanju od deset sekundi 
koju ćete moći da uređujete 
na vremenskoj osi.

Ukoliko samo evidenti-
rate snimak, s njim neće biti 
povezanog materijala. Ime 
datoteke, ime trake, ulazne 
i izlazne tačke vremen-
skog koda, opisi itd, biće priključeni datoteci. Da biste odlomku dodelili status datoteke 
za učitavanje (engl. online), odaberite File>Batch Capture. Pošto ste već evidentirali sve 
parametre, Premiere Pro tačno zna sa koje trake datoteka potiče i koje ime želite da joj 
date. Čak i ako ne želite da serijski učitate odlomak, moći ćete da ga koristite u projektu, ali 
će Premiere Pro, umesto da reprodukuje odlomak, prikazati poruku „Media Offline“.

Snaga ove opcije leži u tome što snimak možete uređivati odmah nakon evidentiranja, 
čak i ako niste učitali materijal. Ako izgubite sav materijal, a sačuvate samo datoteku pro-
jekta, sve dok je snimak ispravno digitalizovan i evidentiran, moći ćete serijski da učitate 
odlomke koji nedostaju i vratite projekat u pređašnji oblik. Jasno obeležavajte trake i moći 
ćete da spasite projekat od propasti.

Odeljak Setup
Odeljak Setup sadrži dva parametra:

Capture (učitavanje). Definiše svojstva učitanog snimka koji hoćete da evidentirate. 
S padajuće liste odaberite Video (video snimak), Audio (zvučni snimak) ili Audio 
and Video(zvučni i video snimak).
Log Clips To (evidentiraj odlomke u). Zadaje lokaciju na kojoj ćete evidentirati 
snimke. Pošto evidentirate direktno u prozor Project, kao odredište možete navesti 
određeno sanduče (engl. bin) u koje će evidentirani snimci biti smešteni.

Projekat ima strukturu sandučića i ona je vidljiva u polju Log Clips To (slika 1.9). 
Ja uvek pravim poseban direktorijum sa imenom Logged Clips i u njega evidentiram 
odlomke. Kada datoteke učitam, kopiram ih ili premestim u drugi direktorijum koji bolje 
odgovara njihovoj nameni.

•

•

Datoteka evidentirana za naknadno učitavanje označava snimak koji nije detektovan na 
vašem sistemu, ali parametri za njega ipak postoje u prozoru Project. Ukoliko datoteku 
slučajno obrišete sa sistema, ikonica i informacije datoteke i dalje će postojati u projektu 
(slika 1.8), ali samo kao evidentirane za naknadno učitavanje (Offline). Pored toga, uko-
liko treba da evidentirate odlomak u prozoru Project, a još ga niste učitali, taj odlomak će 
biti označen kao datoteka za naknadno učitavanje sve dok ga ne učitate.

SLIKA 1.8
Kada odlomak direktno evidentirate u prozor Project, dobijate 
datoteku za naknadno učitavanje. Ta datoteka ima fizičke osobine 
snimka sa svim njegovim svojstvima, ali bez slike i zvuka.
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Odeljak Clip Data
Najbitnija polja nalaze se u odeljku Clip Data (slika 1.10). Ukoliko ste jasno obeležili trake, 
posao će biti lak. Parametri su sledeći:

Tape Name (ime trake). Ime trake koja se nalazi 
u kameri. Treba da ga menjate samo kada ubacite 
novu traku i sa nje počnete da evidentirate.
Clip Name (ime odlomka). Ime dodeljeno 
odlomku koji evidentirate. Premiere Pro imen-
ima automatski dodaje nastavak 01. Na primer, 
ako prvom odlomku date ime Tata_Zabava i pri-
tisnete Log Clip, Premiere će evidentirati odlomak 
i u prozoru Capture prikazati ime Tata_Zabava01. 
Ovo je korisna opcija, ali vam nije uvek potrebna. 
Srećom, svi evidentirani podaci biće provereni pre 
nego što u prozoru Project fizički napravite evi-
dentirani odlomak. 
Description (opis). Detalji o datoteci koje hoćete da zapamtite. Ja datotekama uvek 
dajem jednostavna imena, a detalje beležim u odeljcima Description i Log Note. Za 
odlomak Tata_Zabava, opis bi mogao biti: „Jelena i Joca stižu rano“.
Scene (scena) i Shot/Take (snimak). Broj scene i broj snimka. Koristite ih samo ako 
važe za vaš odlomak.
Log Note (napomena o evidentiranju). Detalji 
o datoteci koji će biti upisani u samu učitanu 
datoteku. Opis datoteke, broj scene i snimka, pove-
zani su s datotekom samo u vašem projektu. Uko-
liko datoteku otvorite u drugom programu za 
obradu, nećete znati da je to bila scena 3, snimak 2, 
videćete samo ime trake, ime datoteke i napomene 

•

•

•

•

•

U prvom izdanju programa Pre-
miere Pro, kada odlomak evidenti-
rate kao Video, ne možete kasnije 
otvoriti datoteku i promeniti joj tip u 
Audio and Video. Ne možete ponovo 
da učitate evidentiranu instancu u 
prozor Capture. Izvesne parame-
tre možete ažurirati, ali su nakon 
evidentiranja datoteke svojstva 
učitavanja (zvuk i video, samo zvuk 
ili samo video) zaključana.

SLIKA 1.10
U polja odeljka Clip Data upisaćete 
sve detalje koji se odnose na evi-
dentirani odlomak ili odlomak koji 
ćete učitati.

Moram da naglasim: izuzetno je 
važno da ispravno evidentirate 
barem ime trake.

SLIKA 1.9
Struktura sandučića u prozoru Project (levo) ista je kao u polju Log Clips To 
odeljka Setup (desno). Sanduče koje izaberete u polju Log Clips To, jeste 
sanduče projekta u koje će evidentirani ili učitani odlomci biti smešteni.
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o evidentiranju. Ako ćete učitane snimke koristiti u odvojenim projektima, u 
polje Log Note prepišite podatke iz poljâ Description, Scene i Shot/Take. U prim-
eru odlomka Tata_Zabava, napisao bih „Mračno i van fokusa kada Jelena razgov-
ara sa Jocom, koristiti samo na kraju“. To je opis i napomena o mojim razmišljanjima 
tokom evidentiranja i predlog za montažera (bilo da sam to ja ili neko drugi).

Sva polja zadržavaju podatke – na primer, kada unesete podatke u polje Description, 
oni će u tom polju ostati i za sledeći odlomak koji evidentirate. Naravno, upisane podatke 
možete obrisati pre nego što potvrdite evidentiranje odlomka. Jedino će broj koji se dodaje 
imenu odlomka u polju Clip Name biti automatski povećan za jedan.

Polja Timecode
Polja Timecode (vremenski kôd) prilično su zgodna. Osim 
što je to još jedno mesto na kom možete pritisnuti dugme i 
zadati ulazne i izlazne tačke, polja s vrednostima vremen-
skog koda jesu aktivna tekstualna polja, pa ćete vrednosti lako 
menjati (slika 1.11). Umesto da loše podešene ulazne i izlazne 
tačke ponovo zadajete, pritisnite i povucite prikazani vremen-
ski kôd ulevo ili udesno da biste smanjili ili povećali vrednost. 
Kada budete zadovoljni, pritisnite dugme Set In (ili Set Out). 
Nakon definisanja ulazne i izlazne tačke, videćete koliko odlo-
mak traje. Desno od ispisa trajanja nalazi se dugme Log Clip, 
koje sve podatke s kartice Logging prebacuje u okvir za dija-
log u kom ih možete proveriti. Pritisnite OK da biste zadatom 
ciljnom direktorijumu dodali nov odlomak kao datoteku evi-
dentiranu za naknadno učitavanje.

Učitavanje snimaka i detektovanje scene
Da biste učitali snimak koji ste upravo evidentirali, pređite na 
karticu Logging prozora Capture i pritisnite dugme In/Out 
(slika 1.12). To dugme govori programu da učita odlomak od 
tekuće tačke In do tekuće tačke Out zadate u prozoru Capture.

Ipak, ukoliko treba da učitate celu traku, razmislite o novoj 
mogućnosti Scene Detect. Pošto DV kamera beleži podatke 
na traku, svaki put kada zaustavite i pokrenete snimanje ona upisuje vreme i datum. Kada 
biste pregledali podatke s trake, mogli biste pronaći svaki snimak na osnovu promena vre-
mena i datuma. Pored toga, detektovanjem scena možete napredovati unapred ili unazad u 
zadatim koracima. Opciju Scene Detect koristićete s dugmetom Tape.

Kada potvrdite polje Scene Detect, učitavanje se prebacuje u režim detektovanja scene 
(Detect Mode). Ova operacija ne utiče na evidentiranje. Međutim, ako pritisnete dugme 
Tape dok je opcija Scene Detect uključena, Premiere Pro počinje da učitava traku od tekućeg 
položaja i nastavlja do kraja trake koristeći funkciju detekcije scene. Premiere Pro jednom 
prolazi kroz traku, a svaku instancu sa oznakom za vreme i datum tretira kao pojedinačan 
odlomak. Čini se da Premiere Pro beleži jednu dugačku datoteku, ali zapravo, svaka instanca 
sa oznakom za vreme i datum daje pojedinačan učitani odlomak. Kada nemam vremena da 
evidentiram traku, ili nisam siguran koje ću delove upotrebiti, učitavam celu traku pomoću 

SLIKA 1.11
Lako ćete menjati vrednosti vre-
menskog koda ako ih pritisnete i 
povučete ulevo ili udesno.

SLIKA 1.12
Kontrole u odeljku Capture kartice 
Logging omogućavaju učitavanje 
tekuće instance In/Out ili učitavanje 
cele trake, počevši od tekućeg 
položaja, pomoću opcije Scene 
Detect. Vrednost Handles definiše 
koliko će dodatnih kadrova pre i 
nakon zadate instance In/Out biti 
zabeleženo.
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opcije Scene Detect i dugmeta Tape, sve odlomke pre-
bacim na vremensku osu i potom obrišem one koji mi ne 
trebaju.

U režimu detekcije scene, Premiere Pro koristi 
podatke unete u polje Tape Name odeljka Clip Data 
i aktivno ime odlomka iz polja Clip Name. Imenu 
odlomka dodaje brojeve koji se uvećavaju za jedan za 
svaki sledeći učitani odlomak. Tokom beleženja ne 
možete svakoj datoteci dati jedinstveno ime, već morate 
kasnije da ga promenite u prozoru Project.

Handles je poslednji parametar u odeljku Capture. 
Taj parametar zadaje broj kadrova dodatih na početak 
i na kraj odlomka koji učitavate. Na primer, ako je 
ulazna tačka 1;01;20, izlazna 1;05;10, a parametar Han-
dles podešen na 20 kadrova, učitani odlomak će početi 
u tački 1;01;00, a završiti u tački 1;06;00. Kada otvorite 

odlomak u projektu, ulazna 
i izlazna tačka i dalje će biti 
1;01;20, odnosno 1;05;10, 
ali dobićete 20 dodat-
nih kadrova. Parametar Handles uvek podešavam na 15–30 
kadrova, pa nikada ne moram ponovo da učitavam dodatni 
materijal da bih snimak uredio kako treba. Dodatni kadrovi se 
dodeljuju samo prilikom serijskog učitavanja (engl. batch cap-
ture) i učitavanja pomoću opcije Scene Detect. Ako učitavate 
slobodnim upisivanjem, neće biti dodatnih kadrova.

Kartica Settings
Kartica Settings prozora Capture (slika 1.13) omogućava pris-
tup brojnim definisanim parametrima, koji su obično sakriveni, 
a u vezi su sa učitavanjem, lokacijom učitanih snimaka i kon-
trolom uređaja.

Odeljak Capture Settings
Odeljak Capture Settings kartice Settings prikazuje format 
učitavanja (na slici je to Recorder) koji ste zadali za projekat. Da 
biste ga promenili, pritisnite dugme Edit. Otvoriće se okno Cap-
ture okvira za dijalog Project Settings. Pritisnite padajuću listu 
Capture Format i izaberite modul učitavanja. Za sve gotove sku-
pove parametara DV uređaja, modul učitavanja je DV/IEEE1394 
Capture. Ukoliko je kod vas instalirana kartica za učitavanje 
nezavisnog proizvođača, biće navedene i druge opcije.

Odeljak Capture Locations
Odeljak Capture Locations (slika 1.14) prikazuje parametre 
radnog diska koje ste zadali za učitavanje videa i zvuka. Dok 

Učitavanje slobodnim upisivanjem 
(engl. free record capture) ne oslanja 
se na instance In i Out vremenskog 
koda. Učitava se ono što se reprodu-
kuje od trenutka kada pritisnete 
dugme Record, pa dok ne zaustavite 
reprodukovanje ili učitavanje. Slo-
bodno upisivanje koristi podatke 
iz poljâ Tape Name, File Name i 
Description, vrednosti vremenskog 
koda i druge metapodatke koji 
su bili aktivni kada ste pritisnuli 
dugme Record. Kada zaustavite upi-
sivanje, možete proveriti ili podesiti 
polja pre nego što snimite učitanu 
datoteku.

SLIKA 1.13
Kartica Settings omogućava brz 
pristup parametrima učitavanja 
(Capture Settings), lokaciji učitanog 
materijala, tj. radnim diskovima 
(Capture Locations) i kontrolama 
uređaja (Device Control). Nema 
potrebe da otvarate parametre koje 
ste definisali, samo aktivirajte kar-
ticu Settings.
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učitavate snimke, tu se ažurira i dostupna količina pro-
stora na radnim diskovima. Prilikom učitavanja možete 
promeniti lokaciju. Pritisnite dugme Browse (uz polje 
Video ili Audio) i pronađite direktorijum koji vam treba, 
pa sa padajuće liste odaberite Custom. Da biste došli do 
podrazumevanog direktorijuma za dokumente u pro-
gramu Premiere Pro, s padajuće liste odaberite My Doc-
uments, ili izaberite opciju Same as Project da biste 
učitavali u direktorijum koji ste već zadali u parametrima 
radnog diska (Scratch Disk Preference). Ukoliko želite da 
različite trake budu učitavane u različite direktorijume, 
učitajte prvu traku, promenite lokaciju u odeljku Capture 
Locations, učitajte drugu traku i tako dalje.

Odeljak Device Control
Odeljak Device Control je prečica do parametara za kontrole uređaja (Device Control 
Preferences). Sve vrednosti možete promeniti kao da ste do njih došli biranjem opcije 
Edit>Preferences>Device Control. Pored toga, vrsta uređaja (ako ste je naveli), videće se  
u polju Current Device. Ukoliko vaša kamera ne reaguje, pređite na karticu Settings, priti-
snite dugme Options u odeljku Device Control, i proverite parametre zadate u opcijama 
DV Device Control. Ako kamera postane nedostupna, poruka o tome će se pojaviti u pro-
zoru Capture iznad oblasti za prikaz.

Meni prozora Capture
Svaki prozor u programu Premiere Pro 
ima sopstveni meni (engl. wing menu) 
(slika 1.15). Meni prozora je prostor za 
prečice do određenih opcija i režima. 
Pošto u programu Premiere Pro možete 
potpuno prilagoditi tastaturu, post-
avljanje funkcija u menije prozora 
omogućava da tim funkcijama dodel-
ite prečice s tastature. Preko menija pro-
zora doći ćete do parametara učitavanja, 
zadavati režim učitavanja, uključivati 
i isključivati detekciju scene i sažimati 
prozor Capture.

Ispravan radni tok
Ukoliko ste naučili šta su parametri učitavanja, koje kontrole su vam na raspolaganju,  
i čemu one služe, obavili ste samo pola posla. Izuzetno je važno pridržavati se efikasnog 
načina rada. Upisivanje vremenskog koda i obeležavanje traka treba da bude vaš prvi  
zadatak (slika 1.16).

SLIKA 1.14
U odeljku Capture Locations 
možete zadati radni disk, tj. putanju 
do lokacije na kojoj će učitani video 
i zvučni materijal automatski biti 
snimljen.

SLIKA 1.15
Meni prozora omogućava pristup nekim prečicama. Pošto opci-
jama popunite meni možete im dodeliti prečice s tastature.
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Vremenski kôd i puštanje traka na prazno
Kada Premiere koristite u DV okruženju nemojte potceniti 
korisno puštanje MiniDV traka na prazno (engl. striping). For-
mat vremenskog koda za MiniDV je takav da, ukoliko kamera 
otkrije praznu traku (statičnu), a vi počnete da snimate, vremen-
ski kôd uvek počinje od 00;00;00;00. To može stvoriti probleme.

Zamislite da ste snimali deset minuta, a onda pogledali 
poslednje što ste snimili. Pokušali ste da pritisnete Stop tačno 
na kraju snimka, ali ste slučajno zaustavili traku na praznom 
prostoru odmah nakon snimka. Kada sledeći put pritisnete 
Record, vremenski kôd će početi od početka, 00;00;00;00. 
Nakon toga biste mogli snimati još 50 minuta i dovršiti 
traku. Tehnički, dobili ste dve identične vrednosti vremen-
skog koda na traci – što evidentiranje i serijsko učitavanje te 
trake može pretvoriti u pravu noćnu moru.

Moglo bi se desiti i da reprodukujete materijal i označite 
ulazne i izlazne tačke prenevši i kratak prazan prostor, a da 
niste ni svesni da on postoji. Prilikom serijskog učitavanja, Pre-
miere Pro automatski učitava sve evidentirane odlomke. Pošto 
prva snimljena instanca sadrži deset minuta sadržaja, a nakon 
nje sledi prazan prostor, čim program pri serijskom učitavanju 
dođe do praznine, tri sekunde će tražiti nov vremenski kôd. Ukoliko u te tri sekunde ne 
pronađe nov vremenski kôd, pretpostaviće da je došao do kraja trake i zaustaviće učitavanje. 
Naravno, ukoliko koristite MiniDV traku, to možda neće zaista biti kraj trake (slika 1.17).

Da biste ispravno pripremili MiniDV trake i efikasnije sa njima radili, preporučujem 
dva koraka pre snimanja kamerom:

Pustite traku na prazno 
snimanje tako da od 
njenog početka do kraja 
postoji neprekidan tok 
vremenskog koda i 
podataka. Tako nećete 
oštetiti traku niti uticati  
na buduće snimanje.
Jasno obeležite traku 
alfanumeričkim imenom, 
kao što je Bleach001 (Ime
Projekta+NumeričkaVre-
dnost). Ukoliko unapred 

obeležite trake, lakše ćete ih pronalaziti kada počnete evidentiranje. Možete dodati i 
opis trake nakon snimanja.

Najbolji način rada pri učitavanju
Pošto ste snimili video, treba da ga učitate. Ubacite traku, prebacite kameru u režim VTR i 
pritisnite taster F5 da biste otvorili prozor Capture. Pre nego što počnem prvo učitavanje, 

1.

2.

04DIA002.eps
0528

3/18/04
SCI

DV Tape

MultiCAM001
MC001

DV Case

MC001

SLIKA 1.16
Neka na traci i njenoj kutiji 
bude isto ime. Možda vam se 
to čini kao elementarna stvar, 
ali od nje počinje dobro orga-
nizovanje biblioteke snimaka. 
Na ovoj slici se na oznaci trake 
nalazi opisno ime i skraćeno 
ime namenjeno evidentiranju 
i učitavanju (MC001).

Pic Pic

04DIA003.eps
0528

3/18/04
SCI

Pic

09:20:13 (7 sekundi) 09:27:13

Snow/Blank

7 sekundi

Pic PicPic

00:00:00:00 00:00:07:00

(7 sekundi)

SLIKA 1.17
Na ovom dijagramu prikazana je 21 sekunda DV trake, i vremenski kôd 
odgovarajućih kadrova video-snimka. Pošto na delu Snow/Blank nema 
snimljenog videa, kada snimanje ponovo krene vremenski kôd će početi 
od vrednosti 00;00;00;00.
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volim da pritisnem Play (L) da bih bio siguran da se brojevi vremenskog koda prenose i da 
vidim snimak. Osnovni koraci učitavanja su:

Umetnite traku i zadajte parametre za materijal koji evidentirate. Ja obično pravim 
nov direktorijum u prozoru Project i dajem mu ime Logged Clips, pa ga izaberem iz 
polja Log Clip To.
U polje Tape Name unesite ime trake. Ukoliko već znate kako ćete nazvati datoteke, 
upišite to ime u polje Clip Name. Na primer, mogao bih uneti ime Bleach_BTS 
(Bleach je moj kratak film, a BTS je skraćenica za „behind the scenes“ – iza scene).
Pritisnite L da biste pokrenuli reprodukovanje.
Kada pronađete prvu ulaznu tačku (In), pritisnite I da biste je zadali.
Ukoliko je snimak dugačak, možete nastaviti reprodukovanje i za to vreme uneti 
opis. Ako za vreme reprodukovanja pritisnete unutar tekstualnog polja, nećete moći 
da koristite prečice s tastature (jer ćete prečicu uneti kao običan tekst u polje) sve dok 
ne pritisnete van polja.
Unesite dodatne metapodatke, zadajte izlaznu tačku (Out) i pritisnite Log Clip. Svi 
uneti podaci pojaviće se u okviru za dijalog u kom ih možete menjati.
Pritisnite OK i Premiere će izabranom sandučetu dodati novu datoteku evidentiranu 
za naknadno učitavanje. Kod mene je to sanduče Logged Clips.

Potom možete nastaviti da evidentirate istu traku ili pređite na neku drugu. Pošto Pre-
miere Pro podržava rad s datotekama evidentiranim za naknadno učitavanje, ne morate 
učitavati video odmah nakon evidentiranja. Kasnije možete izabrati pojedinačne datoteke 
ili grupe evidentiranih datoteka i serijski ih učitati.

Datoteke evidentirane za naknadno učitavanje
Pošto uspešno evidentirate odlomke u prozoru Project, ne morate ih odmah učitati da 
biste ih koristili u projektu. Odlomci s kojima nije povezan sadržaj materijala, biće prika-
zani kao datoteke evidentirane za naknadno učitavanje. Ukoliko pregledate kolone u pro-
zoru Project, videćete sve podatke povezane sa evidentiranom datotekom. Ove datoteke 
možete menjati i koristiti u projektima, kao i svaku drugu datoteku medija (slika 1.18). 
Ipak, one neće prikazivati materijal koji će s njima biti povezan. Možete ih uređivati, opse-
cati i podešavati. Kada ih serijski učitate ili sa njima povežete materijal, on će se prikazati 
sa svim izmenama koje ste uneli.

Serijsko učitavanje
Premiere Pro sadrži nadogradnju na ranije Premiereove funkcije lista za serijsko učita-
vanje. U ovoj verziji, ne samo da možete napraviti i uvoziti tradicionalne tekstualne liste  
za serijsko učitavanje, već projekat možete upotrebiti kao glavnu listu. Zahvaljujući tome, 
Premiere Pro može da evidentira odlomke (učitane ili ne) direktno u otvoren projekat  
(u zadato sanduče). U verziji Pro nije izgubljena funkcija liste za serijsko učitavanje: i dalje 
možete uvoziti i izvoziti pojedinačne liste u formatu podataka razdvojenih zarezom. Ovoj 
verziji je dodata i veoma intuitivna metoda koja produbljuje datoteku projekta i čini je 
vrednijom. Evidentiranjem direktno u prozor Project, podaci o odlomku biće sačuvani u 
datoteci projekta (slika 1.19). Sve dok referencu za odlomak ne obrišete iz prozora Project, 
moći ćete ponovo da ga učitavate na osnovu originalnih evidentiranih parametara.

1.

2.

3.
4.
5.

6.

7.
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Kada evidentirate sve odlomke i smestite datoteke za naknadno učitavanje u sandučiće, 
možete preduzeti nekoliko različitih koraka da biste zadali šta želite da učitate. Ukoliko 
odaberete File>Batch Capture, dok je sanduče Log Clips izabrano u prikazu Master Pro-
ject, iz tog direktorijuma će se učitati sve datoteke evidentirane za naknadno učitavanje, sa 
ispravnim informacijama o traci, imenu i ulaznim i izlaznim tačkama vremenskog koda. 
Ako je izabrana jedna datoteka, Premiere će učitati samo nju.

SLIKA 1.19
Zavisno od kolona koje odaberete za pregledanje i njihovog redosleda, imaćete 
pristup svim metapodacima koji su evidentirani za odlomke. Pored toga, 
možete pregledati i druge podatke i dodavati komentare u namenska polja.

SLIKA 1.18
Datoteke evidentirane za naknadno učitavanje možete otvoriti u prozoru 
Source Monitor i menjati ih na vremenskoj osi. U svim prozorima prikazana su 
svojstva vremenskog koda i audio/video atributi, te obaveštenje da su datoteke 
evidentirane za naknadno učitavanje.
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Ako vam treba nekoliko odlomaka, držite pritisnut taster 
Ctrl i u direktorijumu pritisnite datoteke koje hoćete da učitate. 
Premiere Pro će serijski učitati samo izabrane datoteke. Pro-
gram od vas traži da u kameru ubacite prvu traku s materija-
lom koji treba da se učita, pokreće reprodukovanje i učitava sve 
navedene odlomke sa te trake. Kada završi s trakom, izbaciće je 
i tražiti da ubacite sledeću. Umetnite sledeću traku i pritisnite 
OK da bi se serijsko učitavanje nastavilo.

Da biste dobijali obaveštenja o greškama, preporučujem da 
uključite opciju Generate Batch Log File Only on Unsuccess-
ful Completion, pa će, ukoliko bude grešaka prilikom serijskog 
učitavanja, datoteka s njihovim spiskom biti dodata sandučetu 
u koje su smeštene datoteke za naknadno učitavanje.

Povezivanje medija
Datoteka projekta sadrži sve metapodatke za svaki učitani odlomak, pa možete prekinuti 
vezu i obrisati medij koji je trenutno povezan sa odlomcima. Kada prekidate vezu do 
datoteke, možete prekinuti vezu s datotekama na disku, ili prekinuti vezu i obrisati 
datoteku medija sa diska. U oba slučaja biće sačuvana referenca za odlomak u prozoru 
Project. Ako pokušavate da oslobodite prostor na sistemu, možete prekinuti veze i obri-
sati sve datoteke koje ne koristite u projektu. Te datoteke će ostati vidljive, ali njih ćete 
moći samo naknadno da učitate. Ako vam kasnije ipak budu trebale, izaberite ih i serijski 
učitajte (slika 1.20)

Ovim se još više naglašava važnost 
doslednog imenovanja traka i datoteka: 
ponovno povezivanje i učitavanje biće 
sasvim lako, pa će i vaši projekti biti 
mobilniji i fleksibilniji. Ako hoćete 
da projekat date saradniku, pošaljite 
trake sa datotekom projekta (koja se 
može komprimovati u veoma malu 
datoteku). Kada otvorite projekat, 
videće se da su sve datoteke evidenti-
rane za naknadno učitavanje. Vaš pri-
jatelj samo treba da odabere opciju 
Batch Capture i umetne odgovarajuće 
trake kada program to od njega zatraži.

Ako ste datoteku premestili i Pre-
miere Pro ne može da je pronađe, iza-
berite tu datoteku i opciju Clip>Link 
Audio and Video (pod pretpostavkom 
da vam treba i zvuk i video). Materi-
jal koji tada odaberete biće povezan s 
datotekom u projektu.

Neće svi DV uređaji automatski 
izbaciti traku kada se učitavanje 
završi. DV rikorderi gotovo uvek 
automatski izbacuju traku, ali to ne 
rade i sve DV kamere. Kada se završi 
učitavanje sa trake, dok je prikazan 
okvir za dijalog u kom se traži da 
umetnete drugu traku, možete bez 
brige i ručno pritisnuti dugme Eject 

SLIKA 1.20
Kada sanduče popunite datotekama evidentiranim za 
naknadno učitavanje, možete ga pritisnuti desnim tast-
erom miša i iz kontekstnog menija odabrati Link Media 
da biste sve datoteke ponovo povezali opadajućim redo-
sledom. Ako odaberete opciju Batch Capture, Premiere 
će serijski učitati sve evidentirane odlomke iz sandučeta.
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Izvoženje i uvoženje lista za serijsko učitavanje
Da biste bili sigurni da evidentirane datoteke s vaših traka postoje u prenosivom formatu, 
možete napraviti i izvesti liste za serijsko učitavanje, ili uvesti postojeće liste. Da biste izve-
zli tekstualnu listu za serijsko učitavanje, izaberite direktorijum, odlomak ili više odlomaka 
od kojih ćete napraviti listu, i odaberite Project>Export Batch List. Premiere Pro pravi tek-
stualni dokument u kom su podaci razdvojeni zarezima (engl. comma-delimited). Taj doku-
ment će sadržati podatke u vezi sa odlomcima (slika 1.21).

Uvoženje liste za serijsko učitavanje vrlo je zgodna mogućnost. Odaberite Project> 
Import Batch List, označite listu i pritisnite OK. Premiere Pro će u projektu napraviti 
nov direktorijum koji će imati isto ime kao lista. U tom direktorijumu biće evidentirane 
instance odlomaka svih stavki iz liste. Tekstualna datoteka koja postaje fizička instanca 
odlomka – Premiere Pro je svakako ušao u novi milenijum.

Ručno učitavanje bez kontrole uređaja
Ako ste povezali kameru koja ne podržava kontrolu uređaja ili ako koristite konverter iz 
RCA u DV (ili most, engl. bridge), koji će analogni signal konvertovati u DV podatke za 
prebacivanje FireWire kablom, trebalo bi da isključite kontrolu uređaja (DV Device Con-
trol). Na kartici Settings prozora Capture, s padajuće liste Device odaberite None. I dalje 
ćete koristiti DV Capture Recorder jer u FireWire ulaz stiže signal, ali za taj signal nećete 
imati kontrolu uređaja (slika 1.22).

Na primer, ako ste VCR povezali preko DV pretvarača, na video-rikorderu pritis-
kajte dugmad Play, Pause, Fast Forward i Rewind da biste pronašli segment koji hoćete da 
učitate. Pritisnite G na tastaturi (ili Record u prozoru Capture) da bi učitavanje počelo, a 
zatim G ili Esc da biste ga zaustavili (ili dugme Stop). U odeljku Clip Data prozora Cap-
ture, unesite ime trake, ime datoteke i druge metapodatke koje hoćete da priključite 
učitanoj datoteci. Pošto pritisnete OK da biste potvrdili podatke u tim poljima, Premiere  
će novoučitani odlomak dodati projektu.

SLIKA 1.21
U datoteci liste za serijsko učitavanje, videćete koje se kolone odnose na koja 
polja iz programa Premiere Pro: A je Tape Name, B je In Point, C je Out Point,  
D je Clip Name, E je Log Comment, F je Description, G je Scene, a H je Take.
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Za odlomke koji su učitani 
pomoću FireWire interfejsa uz 
upotrebu pretvarača, vremenski 
kôd ima vrednost 00;00;00;00 u 
kadru 1. Pošto FireWire ulaz ne 
detektuje informacije o vremen-
skom kodu preko kabla, počeće 
vremenski kôd od nule.

Kada odlomke učitate bez  
kontrole uređaja, a samim tim  
i bez vremenskog koda, dobro 
razmislite pre nego što obrišete 
medij a ostanete samo sa eviden-
tiranim datotekama. Pošto ne  
postoji apsolutna metoda koja će 
garantovati da možete ponovo 
učitati te datoteke s potpuno istim 
ulaznim i izlaznim tačkama, mon-
tirani film će se izmeniti ako 
budete morali ponovo da učitate 
materijal.

Učitavanje u pozadini
Nova mogućnost u programu Pre-
miere Pro 1.5 jeste učitavanje u 
pozadini (engl. background capture). Počnete učitavanje, a potom minimizirate Premiere. 
Program će nastaviti učitavanje dok vi na računaru radite druge stvari. Da biste videli video-
-lekciju o toj opciji, pogledajte video-snimak „Background Capture“ s pratećeg DVD-a.

Šta treba da zapamtite
Upisivanje vremenskog koda na trake i obeležavanje traka, najbitniji su delovi proc-
esa učitavanja. Oni će vam olakšati pronalaženje materijala ukoliko dođe do problema. 
Pored toga, možete napraviti rezervnu kopiju tekstualne liste za serijsko učitavanje za sve 
odlomke u projektu. Ta lista se može koristiti kao referenca ili je možete uvesti u drugi pro-
jekat.

Tradicionalni problemi sa učitavanjem obično su problemi s trakama, kao što su nekon-
tinuiran vremenski kôd ili pogrešno obeležavanje. Ako imate ispravan vremenski kôd i 
pridržavate se pravila imenovanja, preostaje samo da vodite računa o ponašanju kamere i 
DV uređaja kada ih povežete sa sistemom. Lekcije koje slede objasniće vam kuda da idete  
i šta da radite da biste ispravno učitavali snimke u Premiere Pro i evidentirali ih.

Sledeće poglavlje vam pomaže da efikasnije radite sa učitanim odlomcima, predstavlja 
vam prozore za prikaz i funkcije prozora Project.

SLIKA 1.22
Ako je kontrola uređaja nedostupna, nećete moći da pristupate  
kontrolama prenošenja.






